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WEBCT INSTRUCTOR RESPONSIBILITIES 
AND HELPFUL TIPS MANUAL 

Overview 
This document will explain how to accomplish various tasks inside and outside WebCT. 
As a designer of WebCT, this document should help you create, facilitate, and maintain 
your WebCT course.  

In this manual you will learn more about: 

 Responsibilities of a WebCT Instructor 

 Quick Tips and Hints for Using Communication Tools in WebCT 

 Tools for Accessing Teaching, and Learning in Your Course 

Responsibilities of a WebCT Instructor 
As the designer or instructor of a WebCT course you have certain responsibilities that 
include:  

 Creating an information (welcome) page  

 Keeping a current back-up of your course 

 Setting or cleaning out the student information of the course at the end of each 
semester 
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Adding a Welcome Page to Your WebCT Course 
By navigating to the CSU WebCT page http://webct.colostate.edu you will see various 
links. On this page you can: 

 Log into WebCT 

 View Faculty Resources 

 View Student Resources 

 Click on the Links and Lists of WebCT Courses and view information about 
courses in WebCT by clicking the  button. 

On Links and Lists of WebCT Courses page, you will see a list of the departments and 
corresponding courses. Some of these courses will have the blue information button listed 
which means that instructors have made a welcome page for the public to view 
information about their course. CSU will use this page to showcase online courses and 
entice students to sign up for interesting courses. 

 

Making a Welcome Page for Your Course 
To make a welcome page, complete the following steps: 

1. Click the Control Panel button in the top left-hand area of the WebCT page. 

2. Select the Course Settings option under the Basic Control Panel. The Course 
Settings screen appear: 

http://webct.colostate.edu
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3. Select the Edit welcome page button under the Create/Edit Welcome Page option. 
The Welcome Page Designer Options appear: 

 
You can add an upper and lower textblock or links to the Welcome page. Clicking the 
Add upper textblock or Add lower textblock link will take you to the screen to add 
text or images. Clicking the Add URL link will take you to Add Link to URL screen. 

Adding an Upper or Lower Textblock 
When you select to add an Upper or Lower Textblock section to your homepage you can 
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select the following options: 

 Layout – Select background color of the page. 

 Text Heading – Enter in the course ID number, name of the instructor, department, 
and contact information. 

 Text – You can use the HTML editor to format course objectives, link to the image 
files and give a schedule of the course. The HTML editor has multiple options to 
format text and images. 

 Image/File – You can also choose to upload a graphic file and place it near or in the 
text.  

 Image Caption – If you insert an image in your welcome page, you can also insert 
an image caption. 

 
When you have completed selecting the options of the Text block page, click the 
Update button. 

Your Welcome page will now be available for public viewing from the Links and 
Lists Welcome page. 

Note: If you would like help creating your welcome page contact the Office of 
Computer Training and Support Services, Christina Nimmo at 491-0905 for more 
information. 
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End of Semester Tasks  
This section will explore the following tasks: 

1. Backing Up Your WebCT Course 

2. Learning How to Reset Your Course 

Note: If you are not the primary designer of the course, and you have not been assigned 
the responsibility to complete the necessary backups and reset the student database, 
consult the primary designer of the course to coordinate these tasks. The primary designer 
should complete these tasks a month after the course has been completed. Resetting your 
course is important because it ensures that the course is ready for the next offering. 

Backing Up Your WebCT Course 
This tutorial will guide you through the process of backing up your WebCT course. 
Ideally, you should back up your course: 

 At the beginning of the semester so that you have a clean copy. 

 At the end of the semester when grades are completed, and BEFORE you make a 
major change to your course in case changes cause problems.  

Important: In the event that you have to restore your backup, everything new in the 
course since your last backup will be lost (this includes student emails and discussion 
postings). Therefore, the more you back your course up, the less you will lose if you need 
to restore the course later.  

To back up your course, complete the following steps: 

1. Log in to WebCT. 

2. Select the appropriate course. 

3. Click the Control Panel button in the top left-hand area of the WebCT page. 

4. Click Manage Course on the Basic Control Panel page. 

5. Select the Backup Course Function. 

6. Under the Actions menu, click the Backup Course button. The Create Backup 
screen appears: 

http://www.ctss.colostate.edu
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Note: Entering a short description in this text box is optional. 

7. Click Create. The successfully created .zip file appears: 

 

Note: The filename includes the course name in addition to the date and time of the 
creation of the backup. (The file above was backed up to ‘christina_demo’ on 
December 3rd). 

8. Click “Continue.” The Backup Courses screen appears: Your course backup file is 
listed on the screen. 

 

Note: You must download the backup file to your computer. Here are the reasons 
why: 

 You can only have one backup file in your course at one time. 

 After 24 hours the backup file is automatically deleted. 

9. Select the radio button next to the filename of your backup file. 

10. Under Actions, select the Download button. 
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11. You will be asked where you would like to save your file. Save it to a location on 
your computer where you can easily retrieve it later. 

Note: Although, the backup file has the .zip extension it is not a regular .zip file. If you 
try to open the backup file using WinZip (or any other zip program) it will not open, and 
you will receive an error message. This file can only be used to restore the entire course. 
If you ever need to restore your backup file, contact Computer Training and Support 
Services at 491-0905. Restoring a backup can lead to the loss of more data if you are 
not 100% sure of what you are doing. 

Learning How to Reset Your Course  

At the end of the semester when your WebCT course has been completed and the 
students have had time to view their grades, you will need to reset your course. This 
process removes the information created specifically for and by the students during the 
semester (including grades, e-mails, and discussion postings). The content you have 
created for the course (content pages, quizzes, etc.) will remain, and your course will be 
ready for the next offering. 

Note: Before you reset your course, you should back it up so that you have a copy of both 
your course and student information. 

When you have backed up your course, follow the steps below to reset your course: 

1. Log into WebCT. 

2. Select the appropriate course. 

3. Click the Control Panel button in the top left-hand area of the WebCT page. 

4. Select the Manage Course option under the Basic Control Panel. 

5. Click Reset Course (you may have to scroll down to see the option). The Course 
Reset screen appears: 

http://www.ctss.colostate.edu
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On the Course Reset screen you can decide what options to delete from your course. If 
you choose one of the reset areas, all student information under this topic will be 
deleted. Most of these categories are self-explanatory but here are a few clarifications: 

3. Student Database: Deletes students and their records (the grade book). When you 
clean up the Student Databases you remove the students from the course, as well as 
their grade book and grades, but not discussions and chat information. 

4. Teaching Assistant Database: Deletes any GTAs in your course. 

Note: No content or information that the Instructor has put into the course will be 
deleted, only student information such as quiz and assignment results and discussion 
and mail correspondence. 

5. Select what you would like to reset (by checking the checkboxes), and click Reset. 
(Normally, you will reset all of these tools except for your GTA if he/she is 
continuing to work for you next semester.) 

Note: Select all, and then deselect the GTA checkmark. 

6. After you see the “Are you sure you want to do this” message, click Yes and WebCT 
will proceed to reset your course. If you have a lot of student-generated information, 
the reset procedure will take a few minutes.  

Note: Remember that student-generated content will remain in your course unless 
you specifically select the WebCT tool to delete the information, so remember to 
select all the areas you want to delete. 

http://www.ctss.colostate.edu


WebCT Instructor Responsibilities Manual 

Page 9 of 24 
© Office of Computer Training and Support Services, Colorado State University 

http://www.ctss.colostate.edu 

Using WebDAV Drag and Drop Capabilities 
WebCT 4.0 supports a new drag and drop file transfer tool called Web-based Distributed 
Authoring and Versioning or WebDAV.   

WebDAV is easy to use and includes the following capabilities: 

 Compatible with Macintosh and PC 

 Has a quick and easy setup 

 Users have the ability to drag-and-drop folders and files to their WebCT course from 
their computer’s file manager 

The setup for WebDAV involves using Web Folders in Windows 98, My Network Places 
in Windows 2000/ME/XP, or the free Goliath WebDAV client for Macintosh computers 
http://www.webdav.org/goliath/. 

A folder must be created for each course the designer will want to access. If you have 
three different WebCT courses, you will need to set up three separate Web Folders in 
your computer’s manage files area so that you can access the files separately in each 
course. 

System Requirements 
WebDAV is compatible with the following browsers: 

 IE 5 or above 

Note: WebDAV does not support Netscape. 

WebDAV is compatible with the following Operating Systems: 

 Windows 95/98/NT/2000/ME/XP 

 MacOS 8.1 or higher (users need to install additional software to use WebDAV. 
Goliath is available from http://www.webdav.org/goliath/). 

Known Problems with WebDAV 
If you choose to setup the WebDAV program on a Windows 2000 or XP operating 
system you may experience a recursive folder problem and may be asked to login to the 
server every time you select a subfolder.  This will be evident when you try to select a 
single folder and there are endless subfolders displayed under the main folder. To remedy 
this problem, you will need to delete the My Network Places connection you created and 
create it again. To fix this problem, create the link again and remove the (:443) port 
number from the URL that references the server. If the request for a login appears when 
selecting a subfolder, select cancel. You do not have to enter a login at this screen.  

http://www.webdav.org/goliath
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Setting Up WebDAV on a PC 
Windows 2000/ME/XP allows you to setup a new Network Place that is used by 
WebDAV to connect to the WebCT server.  

Note: Each WebCT course must have a different link to the Manage Files area. 

To setup WebDAV on a Windows 2000/ME/XP operating system do the following: 

1. Navigate to your WebCT course. 

2. Select the WebDAV Info link from the top of your myWebCT page. The WebDAV 
information appears: 

 

3. Copy the WebDAV URL course files link. 

4. Navigate to your desktop or Windows Explorer.  

5. Click on the My Network Places icon. 

 
6. Select the Add Network Places icon. 
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7. In the Type the location of the Network Places box, paste the WebDAV URL. 

8. Click the Next button. 

9. You will be asked to login with your eIdentity and ePassword. 

 

10. Click OK. The Completing the Add Network Place Wizard box will appear. 

11. Enter a name for your new Network Place. 

 
12. Click Finish. 

Navigate to your computer’s manage files area. You will now have a new Network 
Place displayed under your My Network Places. You will be asked to login when you 
access your course files from this link. 
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Setting Up WebDAV for Windows 98 
Users of Windows 98 will have the same setup procedures as Windows 2000 except the 
Network Places will be titled Web Folders in 98. 

Setting Up WebDAV for Macintosh Systems 
To implement WebDAV on a Macintosh system you will install a program from 
WebDAV called Goliath. There are two versions of this program: 

 Classic MacOS (The Classic MacOS application requires PowerPC based on 
Macintosh running MacOS 8.1 or higher). Information on this program can be found 
at: http://www.webdav.org/goliath/installs/Goliath_1_0_Installer.hqx. 

 Disk Copy archive for Mac OS X (This system requires MacOS X version 10.0.4 or 
greater) Information on this program can be found at: 
http://www.webdav.org/goliath/installs/Goliath1_0.dmg.gz.  

Note: A detailed help package for Goliath can be found at 
http://www.webdav.org/goliath/help0.9. 

Important: Once the Network Place or Webfolders have been set up on your computer, 
you can use WebDAV with any Microsoft Office programs. Be aware, that if you are 
using the WebDAV program to modify files you are modifying files on the server 
and do not have a backup on your computer. 

Using WebDAV with Macromedia Dreamweaver 
You can also use Dreamweaver to connect to WebDAV (Web-based Distributed 
Authoring and Versioning) protocol if you have a system that supports that protocol. Two 

http://www.webdav.org/goliath/installs/Goliath_1_0_Installer.hqx
http://www.webdav.org/goliath/installs/Goliath1_0.dmg.gz
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examples of WebDAV servers currently available are Microsoft Internet Information 
Server (IIS) and Apache Web Server. 

To connect to WebDAV within Dreamweaver, do the following: 

1. Open Macromedia Dreamweaver. 

2. Click Site > Define Sites. 

3. In the Site Definition dialog box, select Edit. 

4. In the Category box, select Remote Info. 

5. In the Access pop-up menu, choose WebDAV. 

6. Click Settings. The WebDAV Connection dialog box appears. 

 
7. In the URL file, enter the complete URL to the directory listed in the WebDAV Info 

page. This URL includes the protocol, port and course server name. 

8. Enter your eIdentity and ePassword in the Username and Password fields. This 
information is for server authentication and not related to Dreamweaver.  

Note: If you do not remember your eIdentity and ePassword contact ACNS at 491-7653. 

9. In the Email field, enter your e-mail address. This is required and is used to identity 
ownership on the WebDAV server and appears in the Site window for contact 
purposes. 

10. Select the Save Password to store your password once you have exited 
Dreamweaver. When you start a new session the password will be saved. 

11. Click OK. 

12. Choose Site > Connect or click the Connect button on the site window tool bar to 
connect too the remote site. To disconnect, choose Site > Disconnect or select the 
Disconnect button. 

Once you are connected to WebDAV in Dreamweaver you can use the file sharing 
features to transfer and modify files in Dreamweaver and your WebCT course. You 
can change you connection information by following the steps above and entering 
new information into the WebDAV connection dialog box. 

http://www.ctss.colostate.edu
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Quick Tips and Hints for Using Communication Tools in WebCT 
Below are tips and suggestions on how to engage students using the Communication 
Tools in WebCT. 

Facilitating Student Interaction  
Below are suggestions on how to engage students in class. 

a. Make the activity a required part of the course - specify this on your course syllabus, 
and designate a percentage of the grade for online participation. 

b. Further require that half of the activity must be between students rather than only 
with the group moderator. Set a realistic number of interactions for both categories 
(say 20 each per quarter for a total of 40). 

c. Carefully focus the discussion arena by setting topic boundaries from the beginning. 
This can be stated within the syllabus and on the web board site. Posts that deviate to 
non-related issues can then be disqualified towards the fulfillment of the participation 
requirement. 

d. Be an active moderator. You're the instructor and this is part of the class. Show the 
students how important it is to add new material every day or so, and interact as 
much as possible with the students. This needs to be a directed activity. 

e. Designate "topic owners" (individuals or small groups from the class) that are 
charged with leading discussions on the board. 

f. Set Conventions for topic posting, (on the site and on your syllabus). This could 
include word limits, and more importantly, naming conventions for posts. A naming 
convention will prevent situations where all of the posts look like "RE:RE:RE:etc." A 
good convention might be the title of the original topic or designated topic. 

g. Set up an index for your topics. Bury hidden treasures in the board and tell the 
students that they may be quizzed on materials or interaction that is ONLY occurring 
online. 

h. Don't drive yourself crazy if everyone doesn't participate. In-class participation rates 
are generally low so if you can match or slightly surpass those, you've made a real 
breakthrough. 

i. Use other tools to help supplement the experience such as: chat, instant messaging, or 
an online synchronous class here and there. All of this will allow the students to feel 
more comfortable using learning technology in the extended classroom. 

http://www.ctss.colostate.edu
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Communication Tools Tips  
Below are helpful hints when dealing with WebCT Communication Tools.  

Discussion Board 
With the Discussion Board you can: 

1. Post asynchronous messages (post messages at any time).  

2. Post messages to the entire class and engage students in a discussion. 

3. Use the Quote button for replies to include the message you are replying to. 

4. Use it to add attachments or links to convey additional information. 

5. Use the “update listing” to see messages posted during your active session. 

6. Display all messages vs. display unread messages. 

7. Compile messages for printing or archiving. 

8. Only have messages deleted by the Designer.  

WebCT Mail 
With WebCT Mail you can: 

1. Post asynchronous messages (post messages at any time). 

2. Send messages to individual students or groups of students.  

3. Use it to send private messages to students or small groups. 

4. Use the Browse button to see a list of students, click on one student or use the Ctrl 
key to select multiple recipients. 

5. Only be used for your course. 

6. Add attachments or links to convey additional information: see below. 
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Online Chat 
With Online Chat you can: 

1. Post synchronous communication (students must be logged in at the same time). 

2. Type your message in the box labeled “Enter your message below” and press 
“Enter” or “Return” on the keyboard.  

3. See that the “Output Interaction Box” displays the discussion. 

4. Ensure that discussions can be recorded. 

Note: Compose your messages in a word processor and then copy and paste them 
into the message box for either Mail or Discussion.  This will allow you to spell 
check your messages before sending them. 

5. Compose your message in your word processor as you normally would and be sure to 
proof read, and spell check. 

6. Copy it to the clipboard by pressing Ctrl+A to select the entire message and then 
Ctrl+C to copy it. 

7. In either Discussions Board or WebCT Mail click on the compose button for a new 
message or the quote button to reply to an existing message. 

8. Click in the message box and Paste the message that you previously copied to the 
clipboard by pressing Ctrl+V. 

Note: If this is a new message, you must select the message recipients and enter a subject. 

File Attachments in Messages 

Reading Attachments 
WebCT may not be able to read RTF or PDF files (or any type of file) as an attachment. 
In this case it will be necessary to first download the file, open your word processor for 
RTF files (Acrobat Reader for PDF files), and then open the file in that application. It 
may even be necessary to change the name of the file on some browsers to the name 
listed on the WebCT attachments screen.  

This method is useful if your computer is configured correctly: 

To read attachments, do the following: 

1. Click the attachment icon on the message. You will see the screen that lists the file 
with a circle next to it. 
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2. Click the circle. 

3. Click the Download button. 

4. On the window that comes up, click the circle next to Open. 

5. Click OK (you might have to do steps #4 and #5 several times). 

It should open in the application that it was saved in. 

Attaching Files 
The following procedure can be used when you need to place your assignments on the 
Discussions Board or WebCT Mail. Using the RTF file allows for better readability and 
virus protection.  

To attach files, do the following: 

1. Create your document in your word processor.  

2. Save the file in .doc format. 

3. Save the file in Rich Text Format (.rtf) file. To do this in Microsoft Word, you need 
to File>Save As.  

4. Change the Save as Type to Rich Text Format (.rtf) and select Save. 

Mac users need to make sure there are no spaces in the file name and end the name 
with .rtf. You should now have two files saved, one in your original format and one in 
rtf.  

5. Log into your course.  

6. Click WebCT Mail (or the Discussions Board if you are posting for all to see).  

7. Click Compose Message.  

8. At the lower right, click Browse, and navigate to where you have your .rtf file saved 
(you may have to do an "all files" in order to see it).  

9. Click Open.  

The full path file name should be in the attach box. 

10. Click the Attach File button and wait for your file to be listed below the button (this 
is very important and is sometimes forgotten).  

11. In WebCT Mail, browse to select the name of the person you want to send it to (this 
is not done on the BB, as it will go to everyone).  

12. Enter a Subject.  

13. Enter a short message in Message Body window, usually telling the person that there 
is an attachment.  
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14. Click Preview and you should see an Attachments button indicating that there is an 
attached file.  

15. If you a satisfied then click Post (or Send on the WebCT Mail). 

Message Formatting 
To format messages, do the following: 

1. To disable the autowrap in WebCT Mail and discussions you can select the Don't 
Wrap button.  This will allow you to create lists and control your paragraph breaks. 

2. To add HTML codes for bold, underline, and color, WebCT accepts simple HTML 
commands in the message boxes.  

To turn text into: 

bold use:  <b>bold </b> 
italics use:  <i>italics</i> 
underline use: <u>underline</u>  
font size use: <font size=4>font size</font> 
color use:  <font color="green">text</font> 

Note: You must include the beginning and ending code or everything from then on will 
be changed.  

You can also mix codes: <b><i><u><font size=4>mixed codes</b></i></u></font>  

There are other html codes that can be used, but these are the most common that students 
may need.  

http://www.ctss.colostate.edu
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Tools for Assessing Teaching and Learning in Your Course 
Below are steps to measure how you as an instructor are performing in class, and to give 
students and other faculty members more information on your course. The next section 
will guide you through adding a student survey and formative evaluation to your course.  

Adding the Formative Evaluation Survey  
We have developed a WebCT survey that can be used as a formative evaluation survey. 
You can upload the survey, and use it as it is, or edit, delete, or add questions to 
customize the content.  

Adding the Survey to Your WebCT Course 
To add the survey to your course, follow the steps below: 

1. Navigate to the http://www.colostate.edu/webct/surveys/formative_evaluation.htm 
Web site. 

2. Click the link Click here to download the Formative Evaluation Survey as a .txt 
file. (After opening the .txt file, select File > Save as to save the file to your 
computer.) 

Since this file is already in WebCT format, all you need to do is to: 

3. Log in to your class as a designer. 

4. Navigate to the Questions Database (see screenshot below). 

http://www.colostate.edu/webct/surveys/formative_evaluation.htm
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5. Select "Import questions from file" (see above) to import this text file.  

6. Click the Go button. 

This action will import the questions in your Questions Database under the category 
"WebCT Use." Once this is done, you need to add the survey to your course, and then 
add those questions to that survey.  

Note: If you feel comfortable about sharing your data, the Office of Computer 
Training and Support Services would like to see trends and opinions of WebCT, and 
online learning from CSU students. Contact Christina Nimmo at 491-0905 for more 
information. 
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Adding the ASCSU Student Course Survey to Your WebCT 
Course 

This document will guide you through the process of adding the ASCSU Student Course 
Survey into your WebCT course. The survey is the same ASCSU survey that you hand 
out in class. Instead of filling out the form in class, students will fill out the form online. 
The submissions will be saved in a secure file, and compiled with all the scantron data. 
You will receive the results via campus mail. The same print you receive when using the 
scantrons will be reproduced and sent to you with your comments attached. 

Adding the ASCSU Survey to Your WebCT Course 

Setting Up the Cover Sheet in WebCT 
Before any students can submit the student course survey for your class, you (the 
instructor) need to create a cover sheet for the survey. This task is to be completed at the 
beginning of every semester. You will create a hidden icon (hidden to students) in your 
WebCT class that links to the web page.  

To create the link to the cover sheet web page, complete the following tasks: (This only 
needs to be done once per course) 

1. Start on the homepage of your course.  

2. Select the Designer Options radio button.  

6. Click the Control Panel button in the top left-hand area of the WebCT page. 

7. Select the Add Page or Tool option under the Basic Control Panel. 

3. Under Pages select URL, and click the Add button at the bottom of the page.  

4. Enter a title for this link (e.g. “Cover Sheet for Survey”).  

5. In the Address field enter: http://www.ois.colostate.edu/survey/cover.htm 

6. Check On an Organizer Page, and select Homepage from the dropdown box. You 
can use a default icon or use one we have created. 

 
7. To use the graphic above, select the radio button Use Custom icon, and click the 

Browse button.  

8. Navigate to the WebCT-Files>icons>csu alternates folder.  

9. Choose icon_coverPage.gif.  

http://www.ois.colostate.edu/survey/cover.htm
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10. Click the Add Selected button.  

Note: Return to the homepage and your icon is displayed. If the icon is not displayed or 
the link does not find the cover page, please make sure that you typed the correct file 
path. You need to hide this icon for the students. Only you (the instructor) should set up 
the cover sheet. 

Hiding the Cover Sheet Survey Icon 
To hide the icon from students, complete the following tasks: 

1. Select the homepage of your course.  

2. At the top of the homepage, select Designer Options.  

3. Select the radio button next to the Cover Sheet icon.  

4. On the right side of the page, select Options > Hide. 

5. Click Go.  

You will now need to set up the link that the students will use to access the survey. Since 
you can add 13 questions of your own to the survey, we have created a web page 
template that you can use to enter your questions. 

Creating the Survey 
You will need to upload the page that contains the survey instructions, modify and add 
your own questions, and specify the course and section number of your class. To help 
you with this process we have created a template for you to use located below.  

http://webct.colostate.edu/CSUshared/common_images/surveyinstructions.htm 

To use and modify this template follow the tasks below: 

1. To open the file in your Web browser, in the location field enter the URL listed 
above. 

2. To save it to your computer select (in your browser, Internet Explorer or Netscape) 
File > Save as. Save it to a location on your computer.  

Note: Save the file and give it a name that it is related to your course. 

3. Close the browser. 

To edit the file:  

4. To open the file with an html editor (Dreamweaver or Word). 

5. Enter your course number and section number and make your changes by adding or 
removing your own questions.  

http://webct.colostate.edu/CSUshared/common_images/surveyinstructions.htm
http://www.ctss.colostate.edu


WebCT Instructor Responsibilities Manual 

Page 23 of 24 
© Office of Computer Training and Support Services, Colorado State University 

http://www.ctss.colostate.edu 

6. Save the file to your computer. 

Uploading the File to Your WebCT class 
1. Log into WebCT.  

8. Click the Control Panel button in the top left-hand area of the WebCT page. 

9. Select the Manage Files option under the Basic Control Panel. 

2. On the right-hand, select Upload button.  

3. Click Upload.  

4. Click the Browse button and locate the file you just edited.  

5. Click Open.  

6. Select the MyFiles folder to save the file.  

7. Click Upload. 

You are ready to create the Student Survey icon on the homepage. 

Creating the Student Survey Icon 
To create the student survey icon, follow the tasks below:  

1. Start on the homepage of your course.  

1. Select the Designer Options radio button.  

10. Click the Control Panel button in the top left-hand area of the WebCT page. 

2. Select Add Page or Tool link at the top of the page. 

3. At the bottom of the page select the Single Page option. 

4. Click the Add button.  

5. Enter a title for this link (e.g. “Student Course Survey”).  

6. In the Page filename field, click the Browse button.  

7. Select the .html page you uploaded to your course.  

8. Check On an Organizer Page and the select Homepage from the dropdown box. 
You can use the default icon or use one that we have created. 

 
9. To use the graphic above, select the radio button Use Custom icon, and click the 

Browse button.  
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10. Navigate to the WebCT-Files>icons>csu alternates folder.  

11. Choose student_course_survey.gif.  

12. Click the Add Selected button.  

Hiding the Student Survey Icon 
Note: You should hide the Student Survey Icon until you are ready for the students to 
complete the survey. 

To hide this icon from the students, follow the tasks below: 

1. Start on the homepage of your course.  

2. Select the Designer Options radio button.  

3. Select the radio button next to the icon you want to hide.  

4. On the right side, click Options select Hide. 

5. Click Go.  

Note: To reveal this icon for the students, follow the same steps as above, but select 
Reveal instead of Hide. 

Important: You need to have students complete the survey during the last two weeks or 
close to exam week for it to be counted in ASCSU summary data. Otherwise, results are 
only returned to the instructor of the course. Please remember that before students can 
complete the survey, you must submit the cover page, fill in all the blanks and make sure 
that the course number and section number match what you have entered on the 
instructions page. 
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